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Workforce Data Workbook Instructions 

1. Requested Workforce Reports 

Requested Workforce Reports 
The workforce reports requested below will be used to populate the CalHR Workforce 

Data Workbook. 

Important Notes: 

Employee information within MIRS is only available to reflect the past 24 months, 

therefore, your organization WILL NEED to run the following reports on a monthly basis 

to obtain the most accurate employee information listed in the MIRS Elements and 

Definitions now and moving forward. 

o COM030 – This report will display a list of current employee information (active 

and temporarily separated). 

o COM031 – This report will display a list of employees with appointments and 

separations in the past 24 months. It includes employee information at the time of 

the transaction. 

 Gather the most current month’s COM030 report 

o Moving forward, you will need to run this report monthly. 

o To have a baseline for analyzing separation data, it is recommended to have a 

minimum of COM030 reports for 6 months to complete the Turnover Worksheet 

and the “Average Age at Retirement” and “Average Years of State Service at 

Retirement” columns within the Retirement Eligibility Worksheet of the CalHR 

Workforce Data Workbook.  

 Gather the COM031 report reflective of the last 24 months  

o When running this report for the first time, include dates from the start of a 24-

month timeframe through the end of the last full month. Then run the report for 

the previous month on a monthly basis moving forward. For example, if you run 

the report on August 25, 2020, run the report for August 2018 through July 2020. 

Then in September, run the report for August 2020. 

o Moving forward, you will need to run this report monthly. 

 Gather Civil Service Employee Demographic Statistical Reports 

o Access the Department 5102 Report specific to your organization. 

o Access the Statewide 5102 Report for comparing against your organization. 

https://www.calhr.ca.gov/workforce-planning/Documents/Workforce%20Data%20Workbook.xlsx
https://www.calhr.ca.gov/workforce-planning/Documents/Workforce%20Data%20Workbook.xlsx
https://www.calhr.ca.gov/workforce-planning/Documents/MIRS%20Fields%20and%20Definitions.pdf
https://www.calhr.ca.gov/workforce-planning/Documents/MIRS%20Fields%20and%20Definitions.pdf
https://www.calhr.ca.gov/Pages/workforce-analysis.aspx
https://www.calhr.ca.gov/Pages/statewide-reports.aspx
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2. Preparing Workforce Reports 

Preparing the COM030 Report  

Important Notes: 

o The instructions provided are based on Microsoft Office 2016 Excel capabilities. 

Different versions of Excel may impact the instructions below and any pre-

populated fields of the Workforce Data Workbook. 

o If analyzing multiple COM030 reports, prepare each report as follows and 

combine into the “Workforce Data” spreadsheet. 

o For additional support using Microsoft Excel, including PivotTables, visit 

Microsoft Offices Support. 

Instructions: 

The COM030 report will be in an Excel sheet. Prepare the sheet as follows: 

1. Open the report. 

2. Confirm as many elements from the MIRS Elements and Definitions are included. 

3. Format the sheet into a table so that it is accessible for manipulating and filtering. 

To do so: 

1. Select cell A1. 

2. Navigate to the “Insert” tab. 

3. Select the “Table” icon. 

4. Select “My table has headers”. 

5. Select “Ok". 

4. Ensure all columns are titled appropriately and formatted with the proper values 

(i.e. “Last 4 of SSN” column should be formatted to numbers with no decimals, 

columns with dates should be formatted as mm/dd/yyyy). 

5. Remove duplicates. To do so: 

1. Navigate to the “Data” tab. 

2. Select “Remove duplicates”. 

3. Select the columns for the following elements: Last Name, Last 4 of SSN, 

and Date of Birth. 

4. Select “Ok”. 

6. Once the report is prepared, copy and paste it into the blank “Workforce Data” 

sheet within the Workforce Data Workbook. 

Preparing Workforce Data for Workforce Data Workbook: 

Generational Breakout Worksheet 

Instructions: 

1. Insert a new column next to the “Date of Birth” column and rename as “Birth 

Year”. 

https://support.office.com/en-us/article/excel-for-windows-training-9bc05390-e94c-46af-a5b3-d7c22f6990bb?wt.mc_id=otc_home&amp;ui=en-US&amp;rs=en-US&amp;ad=US
https://www.calhr.ca.gov/workforce-planning/Documents/MIRS%20Fields%20and%20Definitions.pdf
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2. In the first cell of the “Birth Year” column, type in the following formula with the 

appropriate cell information: =year(cell of date of birth) 

3. Hit enter on the keyboard. The birth year should populate. 

4. Format the column to numbers with no decimals. 

5. Apply formula to the remaining cells of the “Birth Year” column. 

6. Format the “Birth Year” column as the number value. 

o Note: If there is a blank “Date of Birth” cell, the birth year will auto- 

populate as “1900”. 

o Consideration: Asterisk the employees with a 1900 birth year as having 

insufficient data. Compare the total number of employees with insufficient 

data to the total number of employees as a notation when reporting. 

7. Insert a new column next to “Birth Year” and title it “Generational Cohort”. 

8. In the first cell, type in the following formula with the appropriate cell information: 

=IF(AND(cell of birth year>=1925,cell of birth 

year<=1945),"Traditionalists",IF(AND(cell of birth year>=1946,cell of birth 

year<=1964),"Baby Boomers",IF(AND(cell of birth year>=1965,cell of birth 

year<=1981),"Generation X",IF(AND(cell of birth year>=1982,cell of birth 

year<=2004),"Millennials" ,"N/A")))) 

9. Hit enter on the keyboard. The generational cohort should populate. 

10. Apply formula to the remaining cells of the “Generational Cohort” column. 

Creating a Workforce Data PivotTable 

PivotTable Areas Defined: 

o Report Filter: Refers to a specific field of information. 

o Column Labels: States what the columns will be titled. 

o Row Labels: States what the rows will be titled. 

o Values: Function you are requesting the PivotTable to perform. 

Instructions: 

1. Select the entire Workforce Data sheet, except for the headers. 

2. Navigate to the “Insert” tab. 

3. Select the “PivotTable” icon. 

4. Select “New Worksheet”. 

5. Select “Ok”. A new Excel worksheet with populate. 

6. Rename the new sheet as “Workforce Pivot”. 

Preparing the Workforce Pivot for Analyzing Workforce Data 

Instructions: 

1. Find and drag the following fields from the PivotTable Fields List to the “Filters” 

area below the PivotTable Fields List: 

o Class Type 
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o Appointment Tenure 

o Effective Date 

o Age 

2. Find and drag the following fields from the PivotTable Fields List to the “Rows” 

area below the PivotTable Fields List: 

o Class Code 

o Class Title 

3. Find and drag the following field from the PivotTable Fields List to the “Values” 

area below the PivotTable Fields List: 

o Age 

4. Change the “Age” field settings in the “Values” area to “Count of Age”. 

5. Right-click on any of the rows in the PivotTable and select “PivotTable Options”. 

6. Navigate to the “Display” tab and select “Classic PivotTable Layout”. 

7. Select “Ok”. 

8. Right-click on any row in the “Class Code” column and ensure the “Subtotal 

Class Code” option is selected. 

Preparing the COM031 Report 

Instructions: 

If analyzing multiple COM031 reports, prepare each report as follows and combine into 

the “Separation Data” spreadsheet. 

The COM031 report will be in a separate Excel sheet. Prepare the sheet as follows: 

1. Open the report. 

2. Confirm the following element is included: 

o Age 

3. Format the sheet into a table so that it is accessible for manipulating and filtering. 

To do so: 

1. Select cell A1. 

2. Navigate to the “Insert” tab. 

3. Select the “Table” icon. 

4. Select “My table has headers”. 

5. Select “Ok”. 

4. Ensure all columns are formatted with the proper values (i.e. “Last 4 of SSN” 

column and “Age at Separation” should be formatted to numbers with no 

decimals, columns with dates should be formatted as mm/dd/yyyy) 

5. Remove duplicates. To do so: 

1. Navigate to the “Data” tab. 

2. Select “Remove duplicates”. 

3. Select the columns for the following elements: Last Name, Last 4 of SSN, 

and Date of Birth. 
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4. Select “Ok”. 

6. Once all reports are prepared, copy and paste each into the blank “Separation 

Data” sheet within the Workforce Data Workbook. 

7. Create a PivotTable using the “2. Creating a PivotTable” instructions. 

8. Rename the additional sheet as “Separation Pivot”. 

Preparing the Separation Pivot for Analyzing Workforce Data 

Instructions: 

1. Find and drag the following fields from the PivotTable Fields List to the “Filters” 

area below the PivotTable Fields List: 

o Transaction Type 

2. Find and drag the following fields from the PivotTable Fields List to the “Rows” 

area below the PivotTable Fields List: 

o Class Code 

o Class Title 

3. Find and drag the following fields from the PivotTable Fields List to the “Values” 

area below the PivotTable Fields List: 

o Age 

4. Change the Age field settings in the “Values” area to “Count of Age”. 

5. Right-click on any of the rows in the PivotTable and select “PivotTable Options”. 

6. Navigate to the “Display” tab and select “Classic PivotTable Layout”. 

7. Select “Ok”. 

8. Right-click on any row in the Class Code column and ensure the “Subtotal Class 

Code” option is selected.
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3. Populating the Retirement Eligibility Worksheet 

Required Workforce Data Workbook Worksheets 
o Workforce Pivot 

o Separation Pivot 

o Retirement Eligibility 

The Retirement Eligibility worksheet provides the following information for the current 

month’s timeframe: 

o The number of employees at retirement eligibility 

o The number of employees within five years of retirement eligibility 

o The average retirement age for an organization 

o The number of employees at the average organization retirement age 

The worksheet also provides the following reflective of the last 6 or 12 months: 

o The total number of retirements for each classification 

o The average retirement age for each classification 

o The average years of state service at retirement 

Important Note:  

State Service Months can only be obtained in the most current month’s COM030 MIRS 

workforce report. Therefore, if your organization does not have, at minimum, 6 or 12 

months of COM030 reports available, you will not have the ability to complete the 

“Average Years of State Service at Retirement” column. 

Instructions 

To populate the “Class Code”, “Class Title”, and “Number of 

Employees” columns: 

1. Open the Retirement Eligibility sheet. 

2. Label the “Total Number of Retirements”,  

“Average Retirement Age for (6 or 12-month timeframe)”, and “Average Years of 

State Service at Retirement” columns with the appropriate 6 or 12-month 

timeframe of separation data. 

3. Navigate to the Workforce Pivot sheet. 

4. Select the “Civil Service Employee” option(s) in the “Class Type” filter. 

5. Note: The label option(s) for Civil Service employees can vary by organization. 

6. Select the “Permanent” option in the “Appointment Tenure” filter. 

7. Copy and paste “Class Code”, “Class Title”, “Number of Employees” data for Civil 

Service Employees into the appropriate labeled columns of the Retirement 

Eligibility sheet. 

8. Navigate to the Workforce Pivot sheet. 
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9. Select the “CEA or equivalent” option(s) in the “Appointment Tenure” filter. 

10. Note: The label option(s) for CEA or equivalent employees can vary by 

organization (i.e. CEA, C.E.A.). Data for CEA or equivalent employees will need 

to be populated separate from Civil Service employees because CEA level 

employees are not permanent. 

11. Unselect the “Permanent” option in the “Appointment Tenure” filter. 

12. Copy and paste “Class Code”, “Class Title”, “Number of Employees” data for 

CEA or equivalent employees into the appropriate labeled columns of the 

Retirement Eligibility sheet. 

13. Navigate to the Workforce Pivot sheet. 

14. Move “Class Code” from the Row area to the Filter area and select the “SSM III 

or equivalent” option(s). 

15. Note: The label option(s) for SSM III or equivalent employees can vary by 

organization. Data for SSM III or equivalent employees is analyzed separately, 

because in many organizations, SSM IIIs are typically the highest level of civil 

service managerial or supervisory positions. This information can assist with 

focusing succession management efforts. 

16. Select the “Permanent” option in the “Appointment Tenure” filter. 

17. Copy and paste “Class Code”, “Class Title”, “Number of Employees” data for 

SSM III or equivalent employees into the appropriate labeled columns of the 

Retirement Eligibility sheet. 

To populate the “Average Age” column: 

1. Navigate to the Workforce Pivot sheet. 

2. Find and drag the following fields from the PivotTable Fields List to the “Filters” 

area: 

o Class Type 

o Appointment Tenure 

o Effective Date 

o Age 

3. Select the “Civil Service Employee” option(s) in the “Class Type” filter. 

4. Select the “Permanent” option in the “Appointment Tenure” filter. 

5. Find and drag the following fields from the PivotTable Fields List to the “Rows” 

area: 

o Class Code 

o Class Title 

6. Find and drag the following fields from the PivotTable Fields List to the “Values” 

area: 

o Age 

7. Change the “Age” field settings in the “Values” area to “Average of Age”. 

8. Copy and paste the “Average of Age” data into the “Average Age” column for the 

appropriate classifications in the Retirement Eligibility sheet. 
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9. Repeat steps one through eight for CEA or equivalent employees. Ensure the 

appropriate options are selected in the “Class Type” filter and unselect the 

“Permanent” option in the “Appointment Tenure” filter. 

10. Repeat steps one through eight for SSM III or equivalent employees. Ensure the 

appropriate options are selected in the “Class Type” filter and select the 

“Permanent” option in the “Appointment Tenure” filter. 

11. Format the “Average Age” column of data as the number value with no decimals. 

To populate the “At Retirement Eligibility (50+)” and “W/in 5 Years of 

Retirement Eligibility (45-49)” columns: 

1. Navigate to the Workforce Pivot sheet. 

2. Select the “Civil Service Employee” option(s) in the “Class Type” filter. 

3. Select the “Permanent” option in the “Appointment Tenure” filter. 

4. In the “Age” filter, select each item from 50 and above. 

5. Change the “Age” field settings in the “Values” area to “Count of Age”. 

6. Populate the total number of Civil Service employees that are 50 and above 

based on classification into the “At Retirement Eligibility” column of the 

Retirement Eligibility sheet. 

o Note: For classifications that do not have employees that are 50 and 

above, leave cells blank. Do not input zero as value as it will impact any 

data calculations. 

7. Repeat steps one through six for CEA or equivalent employees. Ensure the 

appropriate options are selected in the “Class Type” filter and unselect the 

“Permanent” option in the “Appointment Tenure” filter. 

8. Repeat steps one through six for SSM III or equivalent employees. Ensure the 

appropriate options are selected in the “Class Type” filter and select the 

“Permanent” option in the “Appointment Tenure” filter. 

9. Navigate to the Workforce Pivot sheet. 

10. Select each option from 45 to 49 in the “Age” filter. 

11. Select the “Civil Service Employee” option(s) in the “Class Type” filter. 

12. Select the “Permanent” option in the “Appointment Tenure” filter. 

13. Ensure the “Age” field settings in the “Values” area is set to “Count of Age”. 

14. Populate the total number of Civil Service employees that are between the age of 

45 and 49 based on classification into the “W/in 5 Years of Retirement Eligibility” 

column of the Retirement Eligibility sheet. 

o Note: For classifications that do not have employees that are between the 

ages of 45 and 49, leave cells blank. Do not input zero as value as it will 

impact any data calculations. 

15. Repeat steps one through six for CEA or equivalent employees. Ensure the 

appropriate options are selected in the “Class Type” filter and unselect the 

“Permanent” option in the “Appointment Tenure” filter. 
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16. Repeat steps one through six for SSM III or equivalent employees. Ensure the 

appropriate options are selected in the “Class Type” filter and select the 

“Permanent” option in the “Appointment Tenure” filter. 

To populate the “Total # of Retirements”, “Average Retirement Age”, 

and “Average Years of Service at Retirement” columns: 

1. Open Separation Pivot sheet. 

2. Find and drag the following fields from the PivotTable Fields List to the “Filters” 

area: 

o Transaction Type 

o Separation Date 

3. Find and drag the following fields from the PivotTable Fields List to the “Rows” 

area: 

o Class Code 

o Class Title 

4. Find and drag the following fields from the PivotTable Fields List to the “Values” 

area: 

o Age 

5. Ensure the “Age” field settings in the “Values” area is set to “Count of Age”. 

6. Select the “Retirement” option in the “Transaction Type” filter. 

7. Select the separation report date option(s) in the “Separation Date” filter that 

reflect the most recent 6 or 12-month timeframe. 

8. Populate the total number of retirements based on classification into the “Total 

Number of Retirements” column of the Retirement Eligibility sheet. 

o Note: For classifications that do not have retirements, leave cells blank. 

Do not input zero as value as it will impact any data calculations. 

9. Navigate to the Separation Pivot sheet. 

10. Change the “Age” field settings in the “Values” area to “Average of Age” filter. 

11. Copy and paste the average age at retirement based on classification into the 

“Average Retirement Age” column of the Retirement Eligibility sheet. 

o Note: For classifications that do not have average age at retirement data, 

leave cells blank. Do not input zero as value as it will impact any data 

calculations. 

12. Format the “Average Retirement Age” column of data as the number value with 

no decimals. 

13. Complete steps 14-21 if your organization has the last 6 or 12 months of 

COM030 reports available to populate the “Average Years of State Service at 

Retirement” column. 

14. Navigate to the Workforce Pivot sheet. 

15. Find and drag the following fields from the PivotTable Fields List to the “Values” 

area: 
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o State Service Months 

16. Select the report date option(s) that reflect the last 6 or 12-month timeframe. 

17. Find and drag the following fields from the PivotTable Fields List to the “Rows” 

area: 

o Class Code 

o Class Title 

18. Change the “State Service Months” field settings in the “Values” area to “Average 

Years of State Service”. 

19. Convert the “Average Years of State Service” into years. To do so: 

1. In the cell to the right of the first classification with “Average Years of State 

Service” data, type in the following formula with the appropriate cell 

information: =(cell of average of state service months/12) 

2. Hit enter on the keyboard. The years should populate. 

3. Apply formula to the remaining cells of the “Avg. Years of Service at 

Retirement” column. 

4. Format the column as the number value. 

20. Populate the average years of state service based on classification into the “Avg. 

Years of Service at Retirement’ column of the Retirement Eligibility sheet. 

o Note: For classifications that do not have average years of service at 

retirement data, leave cells blank. Do not input zero as value as it will 

impact any data calculations. 

21. Format the “Average Years of Service at Retirement” column of data as the 

number value with no decimals. 

To populate the totals of each column: 

1. Navigate to the Retirement Eligibility sheet. 

2. At the bottom of each column with numerical data, populate the totals as follows: 

o For the “Number of Employees” column: navigate to the “Home” tab, from 

the “Autosum” formula button, select “Sum” 

o For the “Average Age” column: navigate to the “Home” tab, from the 

“Autosum” formula button, select “Average” 

o For the “Total Number of Retirements” column: navigate to the “Home” 

tab, from the “Autosum” formula button, select “Sum” 

o For the “Average Retirement Age” column: navigate to the “Home” tab, 

from the “Autosum” formula button, select “Average” 

o For the “Average Years of Service” column, navigate to the “Home” tab, 

from the “Autosum” formula button, select “Average” 

o For the “At Retirement Eligibility” column: navigate to the “Home” tab, from 

the “Autosum” formula button, select “Sum” 

o For the “W/in 5 Years of Retirement Eligibility” column: navigate to the 

“Home” tab, from the “Autosum” formula button, select “Sum” 
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To populate the “Average Retirement Age for Organization” and 

“Number of Employees at the Organization Retirement Age”: 

1. Populate the “Average Retirement Age” Organization Total using the total from 

the “Average Retirement Age” column. 

2. Navigate to the Workforce Pivot sheet. 

3. Find and drag the following fields from the PivotTable Fields List to the “Filters” 

area: 

o Class Type 

o Appointment Tenure 

o Effective Date 

o Age 

4. Find and drag the following fields from the PivotTable Fields List to the “Rows” 

area: 

o Class Code 

o Class Title 

5. Find and drag the following fields from the PivotTable Fields List to the “Values” 

area: 

o Age 

6. Select the “Civil Service Employee” option(s) in the “Class Type” filter 

o Note: The label option(s) for Civil Service employees can vary by 

organization. 

7. Select the “Permanent” option in the “Appointment Tenure” filter. 

8. Select the most recent report date option in the “Effective Date” filter. 

9. Select all ages that are at or above the average organizational retirement age. 

10. Notate the total number of Civil Service employees that are at or above the 

average organizational retirement age. 

11. Repeat steps two through ten for CEA or equivalent employees. Ensure the 

appropriate options are selected in the “Class Type” filter and unselect the 

“Permanent” option in the “Appointment Tenure” filter. 

12. Repeat steps two through ten for SSM III or equivalent employees. Ensure the 

appropriate options are selected in the “Class Type” filter and select the 

“Permanent” option in the “Appointment Tenure” filter. 

13. Add the total number of Civil Service, CEA or equivalent, and SSM II or 

equivalent employees that are at or above the average organizational retirement 

age. 

14. Populate the “Number of Employees at Average Organizational Retirement Age” 

in the Retirement Eligibility sheet. 
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4. Populating the Separation Snapshot Worksheet 

Required Workforce Data Workbook Worksheets 
o Workforce Pivot 

o Separation Pivot 

o Separation Snapshot 

The Separation Snapshot worksheet provides the total number of separation types per 

12-month timeframe and uses a trend formula to forecast separations for the next 24 

months. The trend formula may be more suitable for smaller organizations, 

organizations with two years or fewer of data and/or organizations with less complex 

separation year-by-year trends. A trend formula finds the line of best fit giving each 12-

month timeframe’s data equal weight. 

Instructions: 

1. Open the Separation Snapshot sheet. 

2. Label the sheet with the appropriate 12-month timeframes where necessary. 

3. Open the Separation Pivot sheet. 

4. Find and drag the following fields from the PivotTable Fields List to the “Filters” 

area: 

o Transaction Type 

5. Select the “Voluntary” separation option in the “Transaction Type” filter. 

o Note: The voluntary separation label option can vary by organization. 

6. Find and drag the following fields from the PivotTable Fields List to the “Filters” 

area: 

o Separation Date 

7. Find and drag the following fields from the PivotTable Fields List to the “Rows” 

area: 

o Class Code 

o Class Title 

8. Find and drag the following fields from the PivotTable Fields List to the “Values” 

area below the PivotTable Fields List: 

o Last 4 of SSN 

9. Change the “Last 4 of SSN” field settings in the “Values” area to “Count of Last 4 

of SSN”. 

10. Populate the Separation Snapshot sheet with the total amount of voluntary 

separations for each 12-month timeframe of data gathered. 

o Note: You will need to navigate to the Separation Pivot sheet and select 

each 12-month timeframe individually in the “Separation Date” filter to 

determine the total amount of voluntary separations per 12-month 

timeframe. 

11. Navigate to the Separation Pivot sheet 
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12. Select the “Retirement” separation option in the “Transaction Type” filter. 

13. Populate the Separation Snapshot sheet with the total amount of retirement 

separations for each year of data gathered. 

o Note: You will need to navigate to the Separation Pivot sheet and select 

each 12-month timeframe individually in the “Separation Date” filter to 

determine the total amount of retirement separations per 12-month 

timeframe. 

14. Repeat steps nine, ten, and eleven for the Involuntary and 

Health/Disability/Family transaction types. 

15. For classifications that have no separation data, populate the cells with “0” in 

order for the formula to populate correctly. 

16. Populate the “Total Separations” column with the total amount of all separation 

types for each 12-month timeframe. 

17. Click the B4 cell in the “Voluntary Separations” column. 

18. Hit enter on the keyboard. The trend separation formula result should populate. 

19. Follow steps seventeen and eighteen for cells: B5, C4, C5, D4, D5, E4, E5, F4, 

F5. 
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5. Populating the Turnover Worksheet 

Required Workforce Data Workbook Worksheets 
o Workforce Pivot 

o Separation Pivot 

o Turnover Worksheet 

The Turnover worksheet provides the turnover rate of voluntary separations from an 

organization within the last 6 or 12-month timeframe. Additional timeframes can be 

analyzed depending on the amount of data available. Voluntary separations are types of 

separation an organization can influence. 

Important Note:  

If you will not have at least 6 or 12 months of COM030 reports available, you will not 

have the ability to complete this sheet. Move to 6. Populating the Generational Breakout 

Worksheet. 

Instructions: 

1. Open the Turnover sheet. 

2. Label the sheet with the appropriate timeframe and data points where necessary. 

3. Open the Workforce Pivot sheet 

4. Find and drag the following fields from the PivotTable Fields List to the “Filters” 

area: 

o Class Type 

o Appointment Tenure 

o Effective Date 

o Age 

5. Find and drag the following fields from the PivotTable Fields List to the “Rows” 

area: 

o Class Code 

o Class Title 

6. Find and drag the following fields from the PivotTable Fields List to the “Values” 

area:  

o Last 4 of SSN 

7. Change the “Last 4 of SSN” field settings in the “Values” area to “Count of Last 4 

of SSN”. 

8. Select the “Civil Service Employee” option(s) in the “Class Type” filter. 

o Note: The label option(s) for Civil Service employees can vary by 

organization. 

9. Select the “Permanent” option in the “Appointment Tenure” filter. 

10. Select all ages in the “Age” filter. 
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11. Find the total number of employees by classification for the “# of Employees (1st 

data point = start of the 6 or 12-month timeframe)” and “# of Employees (2nd data 

point = current month)” columns. To do so: 

1. Select the option in the “Effective Date” filter that reflects the start of the 6 

or 12-month timeframe. 

2. Populate the total number of employees by classification for the “# of 

Employees (1st data point = start of the 6 or 12-month timeframe)” column 

in the Turnover sheet. 

3. Navigate to the Workforce Pivot. 

4. Select the option in the “Effective Date” filter that reflects the current 

month. 

5. Populate the total number of employees by classification for the “# of 

Employees (2nd data point = current month)” column in the Turnover 

sheet. 

12. Navigate to the Workforce Pivot sheet. 

13. Repeat steps four through eleven for CEA or equivalent employees. Ensure the 

appropriate options are selected in the “Class Type” filter and unselect the 

“Permanent” option in the “Appointment Tenure” filter. 

14. Navigate to the Workforce Pivot sheet. 

15. Repeat steps four through eleven for SSM III or equivalent employees. Ensure 

the appropriate options are selected in the “Class Type” filter and select the 

“Permanent” option in the “Appointment Tenure” filter. 

16. Click the E2 cell in the “Average # of Employees” column. 

17. Hit enter on the keyboard. The average number of employees should populate. 

18. Apply formula to the remaining cells of the “Average # of Employees” column. 

19. Navigate to the Separation Pivot sheet. 

20. Find and drag the following fields from the PivotTable Fields List to the “Filters” 

area: 

o Transaction Type 

o Separation Date 

21. Find and drag the following fields from the PivotTable Fields List to the “Rows” 

area: 

o Class Code 

o Class Title 

22. Find and drag the following fields from the PivotTable Fields List to the “Values” 

area: 

o Last 4 of SSN 

23. Select the “Voluntary” separation option in the “Transaction Type” filter. 

o Note: The voluntary separation label option can vary by organization. 

24. Select each option in the “Separation Date” filter that reflects the last 6 or 12 

months. 
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25. Change the “Last 4 of SSN” field settings in the “Values” area to “Count of SSN”. 

26. Populate the Turnover sheet with the total amount of voluntary separations by 

classification. 

27. For classifications that have no voluntary separation data, populate the cells with 

“0” in order for the formula to populate correctly. 

28. Click the G2 cell in the “Turnover Rate” column. 

29. Hit enter on the keyboard. The turnover rate should populate. 

30. Apply formula to the remaining cells of the “Turnover Rate” column. 
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6. Populating the Generational Breakout Worksheet 

Required Workforce Data Workbook Worksheets 
o Workforce Pivot 

o Generational Breakout Worksheet 

The Generational Breakout worksheet provides the total number of employees in 

various generational and civil service employee groupings. 

Instructions 

1. Open the Generational Breakout sheet. 

2. Label the Generational Breakout sheet with your organization name date where 

necessary. 

3. Open the Workforce Pivot sheet. 

4. Find and drag the following fields from the PivotTable Fields List to the “Filters” 

area: 

o Class Type 

o Appointment Tenure 

o Effective Date 

o Age 

5. Find and drag the following field from the PivotTable Fields List to the “Columns” 

area: 

o Generational Cohort 

6. Find and drag the following field from the PivotTable Fields List to the “Values” 

area: 

o Age 

7. Change the “Age” field settings in the “Values” area to “Count of Age”. 

8. Select the “Civil Service Employee” option in the “Class Type” filter 

o Note: The civil service employee label option can vary by organization. 

9. Select the “Permanent” option in the “Appointment Tenure” filter. 

10. Select the option in the “Effective Date” filter that reflects the most current month. 

11. Find and drag the following field from the PivotTable Fields List to the “Filters” 

area: 

o CBID 

12. Select all the options in the “CBID” filter that reflect “Rank-and-File” employees. 

Options include: 

o C01-C19 

o E (Note: these are temporary/seasonal classifications) 

o E01-25 

o E97 

o All “R” 
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13. Populate the total number of employees for each generational grouping in the 

“Rank-and-File” row of the Generational Breakout sheet. 

14. Navigate to the Workforce Pivot sheet. 

15. Select all the options in the “CBID” filter that reflect “Managers and Supervisors”. 

Options include: 

o E48 

o E58 

o E59 

o E68 

o E79 

o E98 

o E99 

o All “M” 

o All “S” 

16. Populate the total number of employees for each generational grouping in the 

“Managers and Supervisors” row of the Generational Breakout sheet. 

17. Navigate to the Workforce Pivot sheet. 

18. Find and drag the following fields from the PivotTable Fields List to the “Filters” 

area: 

o Class Title 

o Class Code 

19. Select all options in the “CBID” filter. 

20. Select all the options in the “Class Title” filter that reflect “Staff Services Manager 

III”. 

o Note: The Staff Services Manager III label options can vary by 

organization (i.e. SSM III, SSMIII, Staff Services Manager III) 

21. Select the “4802” option in the “Class Code” filter. 

22. Populate the total number of employees for each generational grouping in the 

“Staff Services Manager III” row of the Generational Breakout sheet. 

23. Navigate to the Workforce Pivot sheet. 

24. Remove “Class Code” from the “Filters” area below the PivotTable Fields List. 

25. Select all options in the “Appointment” tenure filter except for “Retirement” 

26. Select all the options in the “Class Title” filter that reflect “C.E.A.” 

o Note: The C.E.A. label options can vary by organization (i.e. C.E.A., CEA, 

Career Executive Assignment) 

27. Populate the total number of employees for each generational grouping in the 

“C.E.A.” row of the Generational Breakout sheet. 

28. Navigate to the Workforce Pivot sheet. 

29. Select all options in the “Appointment” tenure filter. 

30. Select all the options in the “CBID” filter that reflect “Exempt” employees. Options 

include: 
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o E01-21 

o E25 

o E48 

o E58 

o E59 

o E67 

o E68 

o E77 

o E78 

o E79 

o E97 

o E98 

o E99 

o U01-21 

o Note: The reason for pulling all Exempt and Excluded employees is that 

there may be exempt employees listed under excluded CBID codes. 

Additional filtering for exempt employees within excluded CBID codes may 

be needed. 

31. Populate the total number of employees for each generational grouping in the 

“Exempt” row of the Generational Breakout sheet. 

32. Navigate to the Workforce Pivot sheet. 

33. Select all the options in the “CBID” filter that reflect all permanent organizational 

employees (Rank-and-File, Managers and Supervisors, Staff Services Manager 

III). 

34. Populate the total number of employees for each generational grouping in the “All 

Permanent Organizational” row of the Generational Breakout sheet. 

35. To populate the “All Permanent Civil Service” row to reflect statewide information, 

visit the CalHR Workforce Planning Statistics webpage 

o Under “California State Civil Service Employee Age Demographics”, click 

on the Text Only (RTF) and reference the Generational Breakout tables 

for number totals. 

o Populate the “All Permanent Civil Service” row with the appropriate data 

information pertaining to each generational grouping and class type. 

http://www.calhr.ca.gov/state-hr-professionals/Pages/workforce-planning-statistics.aspx
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7. Populating the Demographics Worksheet 

Required Reports 
o Departmental Civil Service Employee Demographic Statistical Report 

• Select your organization from the drop-down menu. 

• Select the most recent “Department 5102 – State Employees by 

Occupational Group and Classification” report for your organization.  

o Statewide 5102 Report – State Employees by Occupational Group and 

Classification 

• Select the most current report 

Required Workforce Data Workbook Worksheet 
o Demographics 

The Demographics worksheet provides the total number of employees within gender 

and ethnicity demographics for an organization compared to statewide civil service 

employees. 

Instructions: 

1. Open the Demographics sheet. 

2. Access and open the most recent “Department 5102 – State Employees by 

Occupational Group and Classification” report for your organization. 

3. Label the Demographics sheet with your organization name and most current 

report date where necessary. 

4. Populate the demographic totals and percentages into the Demographics sheet 

o Note: The totals of sub-demographic categories may need to be 

calculated prior to populating the Demographics sheet (i.e. various 

breakdown of Asian ethnicities). 

5. For demographics that have a total of three or less employees, populate the cell 

with an asterisk to protect the identity of those employees. 

6. Access and open the most current “Statewide 5102 – State Employees by 

Occupational Group and Classification” report. 

7. Copy and paste the demographic totals and percentages into the Demographics 

sheet. 

http://calhr.ca.gov/Pages/workforce-analysis.aspx/
http://www.calhr.ca.gov/Pages/statewide-reports.aspx
http://www.calhr.ca.gov/Pages/statewide-reports.aspx

